SAP2000 (V24) Beam Analysis Tutorial

The following is a step-by-step procedure for analyzing a two-dimensional beam using SAP2000
(v24). The order of some of these steps is not critical; however, all steps should be completed
before the analysis is executed. If you have questions or find instructions unclear or inaccurate,
please contact Dr. Charles Camp.

The following tutorial focuses on determining the reaction and internal forces in the beam
below. Assume the support at A is fixed, B and C are rollers, D is a pin, E is 29,000 ksi, and / is
1,000 in*.
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When you start SAP2000 Version 24, you should see the following interface window:

Flle Edit View Define Draw Select Assign Analyze Displyy Design Options Tools Help &

BL3 ZXS §eaaaq W Y X 177t nd 8]

Use File Menu to Create or Open Model



Step 1: New Model - To start a new problem, select New Model under the File menu.

The New Model window provides many different templates for general structures. From this
menu, you can select the problem's units; the default is Kip, ft, F. You can change the unit when
necessary, and SAP2000 converts the values. In this example, the units are Kip and in. Click on
the Beam icon in the first row of templates.
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Mew Model Initialization Project Information

(O Initialize Model from an Existing File

@ Initiali )

®) Initizlize Model from Default Settings Modify/Show Information...
Default Units Kip, in, F [

Default Materials United States ~

Save Options as Default

it

Select Template

Blank Grid Only Beam 2D Trusses 3D Trusses 2D Frames

3D Frames Wall Flat Slab Shells Staircases Storage Structures
Underground Solid Models Pipes and Plates

Concrete

The Beam template menu should appear.
]

Beam Dimensions

Number of Spans Span Length

|:| Use Custom Grid Spacing and Locate Origin

Section Properties

Beams | Default ||+

Restraints Cancel



In this example, the beam has three spans of 12 ft. or 144 in. Enter the values and click OK.

Beam Dimensions

Number of Spans Span Length

|:| Use Custom Grid Spacing and Locate Origin

Section Properties

Beams | Defautt v+

Restraints Cancel

The SAP2000 interface displays the beam's geometry. By default, the left support is a pin, and
the remaining supports are rollers.
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Since we do not need a 3-D view of the beam, click on the window label and delete the left-
hand side window so that you have an xz view of the beam.
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Step 2: Define Structural Supports - To define the location and type of structural support,
select the support location by clicking on the joint with the pointer. A blue "X" should appear at
the joint to indicate it is currently selected. Next, click on the Assign tab at the top of the
SAP2000 interface, then click the Joint and the Restraints ... button on the bottom toolbar.

S
Restraints in Joint Local Directions
Translation 1 [] Rotation about 1
Translation 2 [] Rotation about 2
Translation 3 [] Rotation about 3

Fast Restraints

‘ OK | | Close ‘ Apply

The Assign Joint Restraints menu appears as shown. Usually, the directions 1, 2, and 3 listed on
the menu correspond to the x, y, and z directions. The Fast Restraints buttons may be used for
most problems when working on two-dimensional structures. If the support conditions for your
problem are not listed in the Fast Restraints section of the menu, you should select the
appropriate combination of restraints.

In this beam example, the support at A is fixed, B and C are rollers, and D is a pin.



Select the far left node with the pointer (an "X" should appear at the joint), then click
the Fixed button and OK. Since B and C are rollers, they are set. Next, click on node D with
the pointer, select the Pin button , and then OK.

After the supports have been defined, the beam problem should appear in the SAP2000
interface window as follows:
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This example's grid lines are unimportant, so they are turned off. Click on the View menu at the
top of the SAP2000 interface and then Show Grid.
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Step 3: Apply Forces — Two loads are applied to the beam in this example.

The first beam element has two equally spaced point loads, and the last has a distributed load.

To apply the point loads on the first element, select the beam element with the pointer, click
on Assign, then Frame Loads, and then Point. The following menu appears. Click on Absolute
Distance from End-l and enter the position and value of the two point loads. This example
shows two 6 Kip loads at 4 ft. intervals (48 in. intervals).

General Options General Options
Load Pattern DEAD - ©) Add to Existing Loads Load Pattern DEAD s ) Add to Existing Loads
Coordinate System GLOBAL © (® Replace Existing Loads Coordinate System GLOBAL - (®) Replace Existing Loads.
Lond Birection Gravity » 7) Delete Existing Loads Lo Direction Gravity 7) Delete Existing Loads
Load Type Force - Load Type Force
Point Loads Point Loads
1 2 3. 4, 1 2 3 4,
Relative Distance 0 025 075 1 Absolute Distance |48 % 0 0 in
Loads 0 0 0 g kip Loads 6 s 0 0 kip
(@) Relative Distance from End-l () Absclute Distance from End-1 () Relative Distance from End-l @) Absolute Distance from End-|
Reset Form to Default Values Reset Form to Default Values
[ o | [ cose | [ Ay | [[ox | [ cose | [ aeety |
|
Click OK, and the loads are displayed on the beam:
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Next, click on the far right element and select Assign, Frame Loads, and Distributed. The
following menu should be displayed. In this example, the distributed load is 3k/ft or 0.25 k/in.
Enter these values into the menu and click OK.
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General Options General Options
Load Pattern DEAD - Add to Existing Loads Load Pattern DEAD s dd to Existing Loads
Coordinate System GLOBAL & Replace Existing Loads Coordinate System GLOBAL ~ place Existing Loads
Lond Dirction T - 7 Delete Existing Loads Lond Direction T » ) Delete Existing Loads
Load Type o . Uniform Load Load Type o - Uniform Load
o Kip/in 023 kip/in
Trapezoidal Loads Trapezoidal Loads
1 2. 3 4 1 2. 3 4
Relative Distance 0 025 075 1 | | Relative Distance 0 025 075 1
Loads. 0 0 0 0 kipfin Loads 0 0 0 0 kip/fin
® Relative Distance from End-I O Absolute Distance from End-1 @) Relative Distance from End-l O Absolute Distance from End-|

Reset Form to Default Values Reset Form to Default Values
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The distributed loading is displayed on the beam.
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The point loads are not deleted; they are currently not displayed. Select Display, Show Object Load
Assigns, Frame, and then OK to see all frame loads.
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Step 4: Set Analysis Options - This example models the beam in the x-z plane. Click on

the Analyze menu at the top of the SAP2000 interface window and then click Set Analysis
Options to limit analysis to variables in the x-z plane. The Analysis Options menu appears as
follows:

Available DOFs

Mux Mur [Fluz R M RY [ RZ

Fast DOFs
Space Frame Plane Frame Plane Grid Space Truss
XZ Plane XY Plane
Tabular File

Modify/Show Automatic Tabular Output Data...

No files specified for automatic tabular output

Advanced SAPFire Options. ..

Cancel

To restrict SAP2000 to variables in the x-z plane, select the Plane Frame button and click OK.



Step 5: Define Material Properties - SAP2000 assumes the loads acting on a structure, including
the weight of each element. In our beam analysis, we assume that each element is weightless.
To define the properties of a material, select the Define menu at the top of the SAP2000
interface window and then click on Materials. The Define Materials window appears as shown
below:

H
You can change the properties of materials on this

Materials Click to:
menu. Select the A992Fy50 (Steel with a y|EId A New ateral
stress of 50 ksi) material in this example and click AI9RRVE0 23 Cony o

the Modify/Show Material... button.

Modify/Show Material...

The Material Property Data window is displayed. e

|:| Show Advanced Properties

=]
S

Cancel
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General Data General Data
Material Mame and Display Color . IMaterial Mame and Display Color .
Material Type Steel Material Type Steel
Material Grade |Grade 50 | Material Grade | Grade 50 ‘
Material Motes Modify/Show Notes... Material Motes Modify/Show Notes...

Weight and Mass Units Weight and Mass Units

Weight per Unit Volume Kip, in, F ~ Weight per Unit Volume I:l Kip, in, F ~
Mass per Unit Volume 7.3456-07 Mass per Unit Volume 7.345E-07

Isotropic Property Data Isotropic Property Data
Modulus Of Elasticity, E Modulus OFf Elasticity, E
Poisson, U Poiszon, U
Coefficient Of Thermal Expansion, A Coefficient Of Thermal Expansion, A
Shear Modulus, G 11153.846 Shear Modulus, G 11153.846

Other Properties For Steel Materials Other Properties For Steel Materials

Minimum Yield Stress, Fy Minimum Yield Stress, Fy

Minimum Tensile Stress, Fu Minimum Tensile Stress, Fu

Expected Yield Stress, Fye Expected Yield Stress, Fye

]
in
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in

Expected Tensile Stress, Fue Expected Tensile Stress, Fue

D Switch To Advanced Property Display |:| Switch To Advanced Property Display
Cancel Cancel

Change the value in the Weight per unit Volume input field to zero. Click OK to return to the
Define Materials window, then click OK again. Now, we have a material named A992Fy50 that
does not weight volume. For this example problem, the default values for the Mass per unit
Volume, Modulus of elasticity, Poisson's ratio, and the Coefficient of Thermal Expansion can be



used. For most linear elastic statically loaded structures, only values for Weight per unit Volume
and Modulus of Elasticity are required.

Step 6: Define Frame Sections - To define the cross-section properties of a structural element,
click on the Define menu at the top of the SAP2000 interface window, then click on Section
Properties, then Frame Sections..., and then the Frame Properties window is displayed.

Properties ekt
Find this property.

FSECT
FSEC1

Import New/ Property.

Add New Property.

Add Copy of Property.

Modify/Show Property.

oK

g

The default Frame Section label is FSEC1. To change the frame section's properties, click
the Modify/Show Property... button. The I/Wide Flange Section window will then be displayed.

a8
Section Name FSEC1 Display Color
Section Notes Modify/Show Notes...
Dimensions Section
Outside height (t3 )
Top fiange width (12 ) L ] Sa Gl
Top flange thickness (f) 028
Web thickness (tw )
Bottom flange width (t2b ) l:l HEHEH
Bottom flange thickness (tfb )
Fillet Radius. Properties
Section Properties...
Material Property Modifiers Time Dependent Properties..
+ A992Fy50 ~ Set Modifiers...
Cancel

To define the material of this frame section, click on the Material pull-down menu and select
our weightless material A992Fy50. Click OK to return to the Frame Properties window, then
click OK again.

In this example, the bean has a moment of inertia value of 1,000 in*. To specify this value, click
Add New Property on the Frame Properties menu. The Add New Property menu is displayed.
For this example, click the Frame Section Property Type dropdown menu, select Other, and
then click on General.
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Select Praperty Type Select Praperty Type
Frame Section Property Type Steel ~ Frame Section Property Type Other -
Click to A0d a Steel Section Attt Cacting
1/ Wide Flange Channel Tee Angle General Monprismatic Section Designer
Double Angle Double Channel Pipe Tube
Rectangular Circular Auto Select List Steel Joist
Cancel Cancel

The Property Data menu is displayed. In this example, the Moment of inertia about the 3 axis
(the strong axis) is 1,000 in*. The Cross-sectional area and the Moment of inertia about the 2
should be small, 0.001, to minimize their effect on the results.

-

|

Section Name FSEC2

Properties
Cross-section (axial) area 0.001 Section modulus about 3 axis (top)
Moment of Inertia about 3 axis 1000. Section modulus about 3 axis (bottom)
Moment of Inertia about 2 axis 0.001 Section modulus about 2 axis (left)

Product of Inertia about 2-3 Section modulus about 2 axis (right)

Torsienal constant Warping Constant (Cw)
Shear area in 2 direction Plastic medulus about 3 axis
Shear area in 3 direction Plastic modulus about 2 axis

CG offset in 3 direction Radius of Gyration about 3 axis

L

CG offset in 2 direction Radius of Gyration about 2 axis
Shear Center Offset (x3)

Shear Center Offset (x2)* * Walue is not used in analysis

B 1T

oK Cancel

Enter the value and click OK. Then click OK on the General Shapes menu, and the Frames
Properties menu is displayed. Note that FSEC2 has been added to the list of sections. Click OK.
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Properties Click to:

Find this property:
[Fsec2 |

EE

Import News Property..

Add New Property.

‘Add Copy of Property...

Modify/Show Property..

Cancel

Step 7: Assign Frame Sections - To assign the frame properties of a structural element, select
all beam elements with the pointer and click on the Assign menu at the top of the SAP2000
interface window, then click Frame, and then Frame Sections. You can assign the same section
properties to multiple elements by selecting all the elements that share the same properties.

Choose the FSEC2 frame element from the Assign Frame Sections window and click OK.

The frame section name is displayed next to each element selected. After the frame sections

have been assigned, the SAP2000 interface window is displayed.
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Step 8: Run Analysis—To analyze the model, press the Run Analysis button. The Set Load
Cases to Run menu will then appear.

Click to:
Case Name Type Status Action
DEAD Linear Static Not Run Run
MODAL Modal Not Run Do not Run
Run/Do Not Run All
Delete All Results
Show Load Case Tree...
Save Named Set
Analysis Menitor Options. Show Messages after Run D Model-Alive
O Newver Show @ If Errors or Warnings
(®) Show After seconds () Always 0K Cancel
L 1

By default, there are two load cases: DEAD and MODAL. More load cases can be added, but
only the DEAD load case is required for this example. Click on the Run Now button. If the
analysis is successful, the Analysis Complete window is displayed and reports that the analysis
is complete. Click OK, and the Save Model File As window is displayed.

2 5> This PC » Local Disk (C:) » camp » Coursework > CIVL4122 > SAP2000 » Chapter 11 v 0 Search Chapter 11

Organize *  New folder =- @

32 Dropbox ” Name Date modified

[ Desktop [ Beam tutorial.sdb
« Creative Cloud Files [ example 115-5.50b

H quiz 5123.5db

H quiz 72 235db

10KB

9KB
10KB
10KB

2 Dropbex
@ OneDrive

@ OneDrive - The University of Memphis
& Charles Camp (cveamp)
[ This PC
3D Objects

B Desktop

[£] Documents

& Downloads

B Music

&= Pictures.

B Videos

‘i, Local Disk (C:)

== cvcamp (\\itnas\uomhome$) (W:)

= civil (\itnas.uom.memphis.edu\groups

= cveamp (Vitnas.uommemphis.eduiuo

T Libraries .

File name: | Beam_tutorial sdb -

Save as type: | SAP2000 Model Files (".sdlb) -

A Hide Folders Save Cancel

When you run a model, SAP2000 creates about 40 temporary files, so it's beneficial to choose a
particular folder to store the SAP2000 files. The Windows Desktop is not a good location. When
a folder is selected, name the SAP2000 model file.
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In this example, the file name is Beam_tutorial. SAP2000 saves the model information in the file
Beam_tutorial.sdb in the selected folder. The SAP2000 interface window displays an
exaggerated deflected shape of the modeled structure.
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Step 9: Print Beam Forces - To get a quick feel for the relative magnitude of the forces in the
beam, click on the Show Forces/Stresses pull-down menu - at the top of the SAP2000

interface, select Frames/Cables/Tendons..., and the Display Frame Forces/Stresses menu is
displayed.

S]

Case/Comba

Case/Combo Name DEAD

Multivalued Options
Envelope (Max or Min)
® Step

Display Type
® Force () Stress
Component

O Axial Foree O Torsion

() Shear 2-2 O Moment 2-2
O Shear3-3

Moment 3-3

Scaling for Diagram
@) Automatic

) User Defined

Options for Diagram

® Fill Diagram O Show Values

‘ Reset Form to Default Values |

‘ Reset Form to Current Window Settings |

‘ 0K ‘ | Close | | Apply ‘
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Select the Moment 3-3 (the strong axis) and then OK; the moment along the beam is displayed.
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The default view is the Fill Diagram, which displays the relative magnitude of the moments.
Negative bending moments are in red, and positive ones are in blue.

Another way to display force information is to unclick Fill Diagram and click on Show Values on
Diagram. In this case, the value of each axial force is displayed next to the elements.
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To view more detail about the forces along an element, click on the element in the SAP2000

interface and right-click. The Diagram for Frame Object # (FSEC2) window is displayed. Below

are the results for each of the three elements in this example.

End Length Offset
Case DEAD o (Location)
j LEnd: | g in
tems  Major (V2 and M3) | Single valued e
Lin
Jt 2
JEnd: | gin
(144.in)

Display Options
O Scroll for Values
® Show Max

Equivalent Loads - Free Body Diagram (Concentrated Forces in Kip, Concentrated Moments in Kip-in)

29354 6 6 11.08
¢ : . )
| a.1zT 13 38
T
|

Resutant Moment

.
o

Deflections

—_—

(O Absolute @ Relative to Beam Ends

() Relative to Beam Minimum

Reset to Initial Units.

Dist Load (2-dir)

0. Kipiin
at144.in

Positive in -2 direction
Shear V2

-8.115 Kip
at48. in

Moment M3

-293.538 Kip-in
at0.in

Deflection (2-dir)

0.009305 in
at72. in

Positive in -2 direction

Units | Kip, in, F

End Length Offset

DEAD » {Location}

Case

HEnd:

tems | Major (V2and W3) - | Single valued

J-End:

Jt 2

0.in

Display Options.
() Scroll for Values
@ Show Max

(144.in)

Equivalent Loads - Free Body Diagram (Concentrated Forces in Kip, Concentrated Moments in Kip-in)
Dist Load (2-dir}

11.08 32677

0. Kipfin

s SiEE

12

2.35

Resultant Moment

4

Deflections
(O Absolute () Relative to Beam Winimum @ Relative to Beam Ends.

Reset to Initial Units

at 144.in
Positive in -2 direction
Shear V2

2.345 Kip
at144.in

Moment M3

-326.768 Kip-in
at144.in

Deflection (2-dir)

-0.014108 in
at72.in

Postive in -2 direction

Unis  |Kip, in, F

Case |DEAD

ttems.

Wajor (V2 and M3) | Single valued

End Length Offset

Display Options

Location)
( '3 O scroll for Values.
e | 0.in @ Show Max

(0.in)

It 4
J-End: | 0.in

(144.in)

Equivalent Loads - Free Body Diagram (Concentrated Forces in Kip, Concentrated Moments in Kip-in)

202

REsULAL Sz

Dist Load (2-dir}

15 73

0.25 Kipfin
at 120.in

Positive in -2 direction

Resuftant Moment

_4

Shear V2

-20.269 Kip
at0. in

[

Deflections

T

Moment M3

484 815 Kip-in
at72 in

(O Absolute

Reset to Inttial Units.

(O Relative to Beam Minimum

—_—

Deflection (2-dir)

0.032589 in
at72.in
Positive in -2 direction

(® Relative to Beam Ends.

unts | Kip,in,F v

You can drag the vertical slider along the element to see the values for the loads, shear,

moment, and deflection.
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To print the results to a file, click the File menu, select Print Tables..., and display the following
menu.

Edit

=-[0 MODEL DEFINITION (0 of 54 tables selected)
+-[] System Data
-0 Property Definitions
-[0 Load Pattern Defintions
-0 Other Definitions
-0 Load Case Defintions
-0 Connectivity Data
-0 Joint Assignments
-0 Frame Assignments
-0 OptionsiPreferences Data
+-[J Miscellaneous Data
B ANALYSIS RESULTS (1 of 10 tables selected)
-] Run Information
-0 Joint Output
=-® Element Cutput
i"E Frame Output
--[ Table: Element Forces - Frames

T T e O O O O O o O Y

Tzble: Element Stresses - Frames
-] Table: Element Joint Forces - Frames

¢ @+ Objects and Elements

-0 Structure Output

Load Patterns (Model Def.)
Select Load Patterns. .
1 of 1 Selected
Load Cases (Results)

Select Load Cases...
1 of 1 Selected

Modify/Show Options...

Output Type

(@ RTF File
() TXTFile
() TXT File wio Splits
() HTML File

Options

Print to File

Print Landscape
Fitter Criteria
Hyperlinked Contents

OooE

Mamed Sets

Save Named Set...

I oK | Cancel

Table Formats File... Current Table Formats File: Program Default

In this example, all we require is the mon the beam, so click on expand the Element

Output item under the ANALYSIS RESULTS section, expand the Frame Output item, and then
click on Tables: Element Forces - Frames. Also, click on the Print to File box and the TXT

file button to define the file format. Click OK and define the name and location of the TXT file.

There is an option for Spreadsheet Format if desired. The file's default location is the same
directory as the problem files. A different location can be specified by clicking File Name and
choosing the desired file location and name.

Turn on the frame labels to correlate the results printed in the output file to frame elements in
the structure. Click the Show Undeformed Shape button / on the main interface to display the

frame element labels. Next, click on the Display Options button , and under

the Frame section of the menu, click on Labels.
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The frame element numbers or any other information displayed in the main SAP2000 interface
can be printed by clicking on the File menu and selecting Print Graphics (the image is sent to
the default printer).

The results of the beam analysis presented in the output file are listed by frame element
number.

Beam_tutorial. sdb SAP2000 v24.2.0 - License #20053*1H34PSURBAAEDPF
31 October 2023
Table: Element Forces - Frames, Part 1 of 2
Table: Elsment Foross - Framec, Part 1 of 2
Frams Hation OwlpuiCace CacaTyps F vz v T [
in Kin Kin Kin Kipsin KR
1 o DEAD LinStatic o -B.115 o o o
1 24 DEAD LinStatic o -B.115 ] o ]
1 43 DEAD LinStatic o -B.115 o o o
1 43 DEAD LinStatic o 2415 o o o
1 T2 DEAD LinStatic o 2115 ] o ]
1 o DEAD LinStatic o 2115 o o o
1 =3 DEAD LinStatic o .BES o o o
1 130 DEAD LinStatic o 3.BES ] o ]
1 44 DEAD LinStatic o 3.BE5 ] o ]
2 o DEAD LinStatic o 2.345 o o o
2 24 DEAD LinStatic o 2.345 ] o ]
2 43 DEAD LinStatic o 2.346 ] o ]
2 T2 DEAD LinStatic o 2345 o o o
z o DEAD LinStatic o 2.345 o o o
2 130 DEAD LinStatic o 2.345 ] o ]
2 144 DEAD LinStatic o 2345 o o o
3 o DEAD LinStatic o 20,284 o o o
3 24 DEAD LinStatic o -14.263 ] o ]
3 43 DEAD LinStatic o -B.264 o o o
3 T2 DEAD LinStatic o -2.364 o o o
3 o DEAD LinStatic o 2731 ] o ]
3 130 DEAD LinStatic o 5731 o o o
3 144 DEAD LinStatic o 16731 o o o
Table: Element Forces - Frames, Part 2 of 2
Tabla: Elsment Foross - Frames, Part 2 of 2
Frams Satlon OwlpuiCacs M FrameElem  Elsm 3ation
in Kip-in In
1 o DEAD -203.538 11 o
1 24 DEAD -BE.TED 11 4
1 43 DEAD o 1.1 42
1 43 DEAD = 1.1 42
1 T2 DEAD 14E.7E0 11 T2
1 o DEAD 187.538 11 o
1 o DEAD 187.538 11 =3
1 130 DEAD 104.308 11 130
1 144 DEAD 14.077 1.1 144
z o DEAD 14.077 24 o
2 24 DEAD -45.231 21 4
2 43 DEAD -104.538 24 48
2 T2 DEAD 15T.B45 24 TE
2 o DEAD 214,154 21 =3
2 130 DEAD 27042 24 130
2 144 DEAD -126.764 24 144
3 o DEAD -326.764 21 ]
3 24 DEAD BT.BS2 21 4
3 43 DEAD 358154 LR 48
3 T2 DEAD 4B4.B15 R Tz
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Note that SAP2000 lists the variation of the internal forces and moments along the element.
For beam analysis, there are bending moments and shear forces. The values in the "M3"
column are the nt about the strong axis.
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